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Workflow
Welcome to the POD HD500 Edit Pilot’s Guide. This guide contains details of the POD® HD500 
Edit application’s features and functionality. All behaviors are the same on Mac® or Windows®, 
unless otherwise noted. It is recommended that you also read the POD HD500 Pilot’s Guide and 
Advanced Guide for details on using your POD HD500 device. These documents can be downloaded 
at http://line6.com/support/manuals.

 

This Guide covers POD HD500 Edit version 1.03 and POD HD500 hardware with Flash Memory 
version 1.30 installed (or later versions). POD HD500 Edit is compatible with Mac OS® X 10.5 & 
10.6, and Windows® XP, Vista & 7 (all 32 bit and 64 bit versions). For the latest available software and 
Flash Memory versions, please see “Using Line 6 Monkey” on page 7•1.

What’s in it for Me? 

POD HD500 Edit is a simple, but powerful, Preset editor/librarian application. It allows you to 
easily see and tweak all the individual Amp, Preamp & FX Models’ parameters within one attractive 
Graphical User Interface (or “GUI”), to create, customize, manage and backup your Tone Presets & 
Set Lists. You can also tap into the Line 6 CustomTone™ site to share your POD HD500 Tones and 
download from the huge library of artist & user Presets! In this chapter, we’ll focus on some of the 
common tasks you’ll perform with the POD® HD500 Edit application.

Workflow Overview

Once the POD HD500 Edit application is launched, it automatically “receives” the complete contents  
of all 8 Set Lists from your device’s internal memory, allowing you to view or customize any Preset’s 
Amp & FX Model settings. While connected, communication between the application and your POD 
HD500 device’s internal memory is instant - move any Block or adjust any parameter within the 
application and the modified settings are heard on your device. Likewise, adjustments made to your 
device’s controls are visually reflected in the software. 

Two-way communication exists between your device & computer via the USB connection

This interactive communication allows you to tweak any individual Amp or FX Models’ settings 
within the application GUI and instantly hear and preview the changes, before committing them to 
the internal memory of your POD HD500 device. 

TIP: It is also possible to use POD HD500 Edit simultaneously when using POD HD500 for (USB) 
computer recording, or when using a L6 LINK™ connection to DT50™Amplifiers! When using the L6 
LINK connection, USB audio is muted, however, you’ll still hear your tones through the DT50 and other 
POD HD500 outputs. 

http://line6.com/support/manuals/
http://line6.com/customtone/
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Settings changes made to your current Preset within the software are temporarily stored on your POD 
HD500 - that is, they do not overwrite the device’s current Preset until you perform a save. You can also 
move Presets to different Channel locations (in the same or different Set List) within the application, 
to manage the contents of your device’s Set Lists/Presets order. Once you are done with your Tone 
tweaking, you can “send” one or all the current Set Lists or Tone Presets from the application to your 
device to save all settings within your device’s internal memory. You can also choose to save Set Lists, 
Bundles and/or Presets to your computer’s hard drive to build an unlimited library of Tones, which you 
can reload into the application, and to your POD HD500, at any time. 

Computer Connectivity

To put POD HD500 Edit to work, connect your POD HD500 device to your computer’s USB 2.0 port 
to establish two-way communication. Exit any Line 6 applications that might be running, and with 
your POD HD500 device powered on, launch POD HD500 Edit:

•	 On Mac®, go to Applications > Line 6 > POD HD500 Edit

•	 On Windows®, go to the Start button menu > Programs > Line 6 > POD HD500 Edit

Upon launch, the application will detect your POD HD500 and automatically retrieve and load its 
saved Presets. This may take a few moments since the contents of all 8 Set Lists are being transferred 
- the progress screen will let you know when complete.  

Preset load progress screen

If your POD HD500 device is not USB-connected and powered on, you’ll see the following alert 
screen, warning you that no device was detected. 

No Device alert
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Click OK and you can either continue to run POD HD500 Edit in “Offline Mode” (see page 1•6), or, 
connect/power on your device and the application will prompt you to retrieve the connected device’s 
Presets.

Receive Presets prompt

If you disconnect or power off POD HD500, you’ll see a flashing alert, as shown below, indicating that 
the POD HD500 device connection was lost. Reconnect your device and you’ll be prompted with 
the Receive Presets screen, as described above. Click “Yes” to retrieve all Presets from the device’s 
internal memory, or “No” to continue working in the application without importing the Presets.

Alert indicating no connected POD HD500 was detected

POD HD500 Edit - Offline Mode

In some cases, you might want to load one of your saved Set Lists or Bundles from your hard drive, 
tweak, rename or reorder your Presets, and save the Set List/Bundle back to your computer without 
committing it to your POD HD500 device... No problem! To do this, launch the POD HD500 Edit 
application without your device connected. You see the pop-up alert telling you this will launch the 
application in “Offline Mode” - click OK to proceed.

Offline Mode alert

Load your desired Preset/Set List/Bundle file using the File menu’s “Open” commands, edit to taste 
and save the file back to your computer. At a later time, when you are ready to save the Preset/Set List/
Bundle to your device, connect your POD HD500 and then launch the application. Open the saved 
Preset/Set List/Bundle, and use the Save Panel’s “Send” functions to save the desired items into your 
device’s memory.
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Dynamic DSP

As covered in the POD HD500 Advanced User Guide, the POD HD500 device offers a vast number 
of HD Amp and FX of all types. Some Models require more Digital Signal Processing (DSP) than 
others, so we’ve implemented a “Dynamic DSP” management system in POD HD500 to allow you to 
mix and match any combinations of Models, and the device will automatically bypass Models if the 
DSP limit is reached. You’ll be notified whenever this DSP limit is reached by the following alert:

DSP Limit alert displayed momentarily in the SFV pane

Likewise, you’ll see a similar “DSP Limit Reached” alert displayed temporarily on your device’s LCD 
screen. To alleviate the DSP load, you can toggle existing FX “Off” or set Blocks to “Null,” or try 
switching to different Amp or FX Models. The HD Amps, Reverbs and Pitch type FX Models tend to 
be the heaviest DSP usage Models. However, even among Models of the same type, DSP requirements 
vary - Simply trying a different Amp, Reverb or Pitch FX Model may be enough to bring your Tone 
back below the DSP Limit. 

Saving and Opening POD HD500 Preset Files

Note that there are two methods for “Saving” within the Line 6 POD HD500 Edit application. The 
Save Panel allows you to “Send” one or all Presets from the application to your POD HD500 device - 
see page 2•1.

The other way to “Save,” as covered here, is to create a copy of a Preset to any folder on your computer 
as a POD HD500 Edit Preset (.h5e) file. This allows you to create a library of Presets that can be 
reloaded onto your device anytime! 

To Save a Preset to your Computer:

Double-click on a Preset within the application’s main Presets Panel or Set Lists View to load 
it and then select “Save As” from the File menu. This launches the familiar Mac® or Windows® 
file “Save As” window, where you can edit the file name and choose a destination folder. By 
default, all .h5e files are saved to:

•	 Mac® - /Documents/Line 6/Tones/POD HD500 Edit folder

•	 Windows® - \My Documents\Line 6\Tones\POD HD500 Edit folder

It is also possible to drag any Preset directly from the main Presets Panel or Set Lists View and drop 
it onto your Desktop, or into any folder on your computer to copy it there. Or, select multiple Presets 
to drag and Save copies of each in one drop! (See the “Set Lists and Presets” on page 6•1 for more on 
copying & moving Presets.)
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To Save a Bundle to your Computer:

POD HD500 Edit allows you to instantly save all the applications’ current Set Lists, including 
all their Presets and current settings, into one consolidated “Bundle” (.h5b) file. This is 
extremely handy for making a complete, consolidated backup of all your current Set Lists & 
Presets, allowing you to load them all back to your device at any time! Just go to the File 

menu and select “Save Bundle As” to launch a “Save As” dialog, where you can enter a name and 
choose any folder to save the Bundle file.

By default, all .h5b files are saved to:

•	 Mac® - /Documents/Line 6/Tones/POD HD500 Edit/Bundles folder

•	 Windows® - \My Documents\Line 6\Tones\POD HD500 Edit\Bundles folder

Note that the Save Bundle feature always includes all Set Lists & Presets, regardless of any Preset(s) 
that might be selected within the Set Lists or Presets Panel.

To Save a Set List to your Computer:

POD HD500 Edit allows you to instantly save the currently loaded Set List, including all its 
Presets and their current settings, to a Set List (.h5s) file. This is extremely handy for making a 
complete backup of all Presets in the current Set List, allowing you to load them all back to 
your device at any time! Just go to the File menu and select “Save Set List As” to launch a 

“Save As” dialog, where you can enter a name and choose any folder to save the file. By default, all .h5s 
files are saved to:

•	 Mac® - /Documents/Line 6/Tones/POD HD500 Edit/Setlists folder

•	 Windows® - \My Documents\Line 6\Tones\POD HD500 Edit\Setlists folder 

Note that the Save Set List feature always includes all the Set List’s 64 Presets, regardless of any 
Preset(s) that might be selected within the Presets or Set List Panel.

To Open a Preset, Bundle or Set List File from your Computer 

Opening any of these files loads the file Preset(s) into the editor application. Note that these are 
loaded in the application as “edited” and the Preset title and settings on your connected POD HD500 
are not overwritten until you choose to “send” them to your device, as described below.

A newly opened Set List - all Presets appear as “unsaved” in application until Sent to POD HD500
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•	 To open a Preset - Select “Open” from the application’s File menu and browse to the location 
where your Preset (.h5e) files are stored (the default Preset folder locations are shown above). 
Selecting a Preset file loads its saved settings, replacing the currently loaded Preset and its 
Channel location within the application. 

•	 To open a Bundle - Select “Open Bundle” from the application’s File menu and browse to the 
location where your Bundle (.h5b) files are stored (the default Bundle folder locations are shown 
above). Selecting a Bundle file loads its full set of all 8 Set Lists and their Presets, replacing all 
the currently loaded Presets within the application.

•	 To open a Set List - Select “Open Set List” from the application’s File menu and browse to the 
location where your Set List (.h5s) files are stored (the default Set List folder locations are shown 
above). Selecting a Set List file loads its full set 64 Presets, replacing all the currently loaded 
Presets within the currently loaded Set List within the application.

•	  Alternatively, you can drag a Preset, Bundle or Set List file from any folder on your computer 
and drop it directly in the POD HD500 Edit window to load the file’s settings. (Dragging and 
dropping a Preset or Set List replaces the currently loaded Preset or Set List in the application.)

•	 Use the Save Panel options (see page 2•1) to “Send” the desired Selected Presets/Set List/All to 
your connected POD HD500 device’s internal memory. This action permanently overwrites the 
respective Presets within your device’s internal memory.

POD HD500 - Looper Functions

The POD HD500 Looper functions are not accessible within the POD HD500 Edit application. These 
features are still available via the device’s on-board switches while using POD HD500 Edit, however, 
there are no functions within the application’s GUI to specifically control the Looper functions. The 
following behaviors apply: 

•	 The Looper Block is not accessible within the Edit application, so you won’t see it in the Signal 
Flow View of the software. Therefore, its “Pre” and “Post” position options are accessible strictly 
from the POD HD500 hardware. (The Looper blocks Pre/Post setting is a global one, so it is not 
saved per Preset.)

•	 If you set your POD HD500 device into an active Looper mode (Record, Overdub or Play), the 
application simply remains showing the same currently loaded Preset.

•	 Double-clicking on a Preset within the Presets or Set Lists Panel loads the saved Preset in the 
application and on the device. If the device is currently in an active Looper mode, it will simply 
remain in this mode, and the saved Preset settings will be audibly loaded.
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GUI Overview
In this chapter, we’ll describe the sections of the POD® HD500 Edit application’s Graphical User 
Interface (GUI). Here we’ve laid out descriptions for all the important things you need to know as you 
start clicking around in there.

41

2

3

5

The POD HD500 Edit main “GUI” 

1 Save Controls

The Save Controls allow you to “Send” and “Receive” Tone Presets or complete Set Lists between the 
application and the POD HD500 device’s internal memory. 

The Save controls

Using the SEND buttons overwrites the existing Preset/Set List data in your device’s internal memory, 
effectively Saving the transferred items to your POD HD500. Using the RECEIVE buttons imports the 
last saved versions of the selected Presets or Set List into the application. Please see the chapter “Set 
Lists and Presets” on page 6•1. 
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2 Inputs Panel & Tap Tempo Options

 
Input Source selectors

•	 Input Sources: Choose the sources for Inputs 1 & 2 (these options are the same as those 
found in your POD HD500 Setup:Inputs screen) and are saved individually per Preset. (Note 
that additional Variax® “VDI” Input options are available in the Mixer screen “Variax Input 
Controls” on page 4•1.)

Tap Tempo options

•	 Tap Tempo Options: Enter in a “Tap Tempo” value by clicking directly in the text box to type 
in a specific BPM, or “tap” rhythmically on the LED button with your mouse. Your tempo-based 
FX can optionally be set to a note division of this Tap Tempo value (see below). 

About Tempo Sync

Tempo-based FX (Modulation, Pitch & Delays) each include their own, individual “Tempo Sync” 
option to either follow the Tap Tempo BPM value, or to be set manually. Additionally, a “system” 
Tempo Sync option is also available that allows you to choose whether the FX follow the Tap Tempo 
as a per-Preset value or globally - see “Tempo Sync & Trails Options” on page 4•3.
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3 Presets Panel

The main Presets Panel displays all 64 Channel locations (01A through 16D) that correspond to the 
respective Set List’s Channel locations within your POD HD500 device’s internal memory. 

Set List selector

Edited Preset (indicated in 
amber, italicized text, with 
an asterisk at right)

Currently loaded Preset 
(indicated by arrow at left) 

Selected Preset (indicated 
by highlight)

The Presets Panel

Within the Presets Panel, you can load a new Set List and/or Preset as well as perform all kinds of 
functions with your Presets, including moving or copying them to different Channel locations, using 
the Save Controls to “send” and “receive” Presets between your computer and device, and more. Please 
see “Set Lists and Presets” on page 6•1 for all you need to know about working with Presets.

4 Signal Flow Panel

This panel is essentially the equivalent of the Signal Flow View screen on your POD HD500 hardware. 
It provides a handy visual reference of the On/Off/Disabled state and signal flow position of all Amp 
& FX Models for the loaded Preset.

Off (Bypassed) 
FX Model 

FX Block 
in Path A 

Amp B Amp B Mixer 
Block 

“Null” (Disabled)
FX Blocks 

“Pre” Position “Post” PositionParallel Paths A & B

The Signal Flow Panel

•	 Pre Position: The area before the Path A & B split is referred to as the “Pre” Position. Note that 
FX Blocks placed here are positioned “Pre” Amp Blocks. (An Amp Block can also be placed in 
the Pre position area, but will always be at the end of the Pre section.)
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•	 Parallel Paths A & B: The top signal path is Path A and the lower is Path B. It is possible to 
move FX and/or an Amp Block into each of these paths, to create a “parallel” configuration. 
We’ll cover the possibilities in other sections of this Guide, but here are some pointers for Paths 
A & B:

•	 To utilize two Amps in your tone, it is necessary to move your Amp Block into Path A, 
and an Amp B Block is automatically added to Path B, for which you can select an Amp B 
Model. 

•	 Any of the 8 FX Blocks can be moved into either Path A or B, and placed before of after an 
Amp Block within the path. 

•	 The POD HD500 Source Input 1 is fed through Path A, and Source Input 2 is fed through 
Path B, unless a mono FX Model is inserted in the Pre position, which down-mixes the two 
input sources to mono and feeds them both equally into Paths A and B. (See the Input 
Selectors section on page 2•2.) Note that you can move all FX and Amp Blocks out of these 
Paths completely, but the Paths always exist, and your Source Inputs are always fed through 
them, and thus, through the Mixer Block.

•	 Use the Mixer Block to independently adjust the Level and Pan for Path A and B (also see 
“Mixer Block & Variax Options” on page 4•1).

•	 Post Position: The area to the right of the Mixer Block is referred to as the “Post” Position. 
Note that FX Blocks placed here are positioned “post” Amp Blocks. (An Amp Block can also be 
placed in the Post position area, but will always be at the start of the Post section.)

See “Signal Flow View Features” on page 2•5 for details on all the functions available for this panel!

5 Edit Panels

This area of the GUI offers 5 buttons to display each of the different Edit Panel Views - FX, Amps, 
Mixer, Controllers and Set Lists.

Edit Panel display selector buttons

The Edit Panel display - FX Edit Panel view selected
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We’ve provided detailed info on each of these Views in the following sections:

•	 FX View: Provides full editing capabilities for each of the 8 FX Blocks - see “Working with FX 
Edit Panels” on page 3•1.

•	 Amps View: Provides full editing capabilities for the 2 Amp Blocks, including speakers Cab, 
Mic, DT50™ amplifier parameters and more - see “Working with Amp Edit Panels” on page 3•5.

•	 Mixer View: Provides editing of the Path A/B Mixer, L6 LINK™ Audio & Control options and 
Variax® input - see “Mixer View” on page 4•1.

•	 Controllers View: Provides editing of the footswitch & pedal controller assignments, both for 
control over your Preset’s Amp & FX functions as well as for independently transmitting MIDI 
Control Messages - see “Configuring Footswitches & Controllers” on page 5•1.

•	 Set Lists View: The Set Lists “Librarian” screen provides access to the contents of all 8 Set Lists, 
for easy management of Set Lists and Presets - see “Set Lists and Presets” on page 6•1.

Signal Flow View Features

Just like on your POD HD500 device, the Signal Flow View (SFV) is the primary screen for referencing 
all the sonic elements of your current Preset. This SFV Panel remains in sync with your connected 
device’s SFV “Home” screen - changes made via the hardware or software are reflected in both.* Here 
within the software’s SFV panel, you can click directly on any FX or Amp Block to move its Block, 
or access its parameters in the respective Edit Panels below. All changes made within the Signal Flow 
panel are saved individually per Preset. 

*Note: The Looper Block and other Looper functions are not displayed or accessible within the POD 
HD500 Edit application - see “POD HD500 - Looper Functions” on page 1•6.

FX & Amps On/Off/Null States

All FX & Amp Models include an On/Off “LED” button (see “FX Panel Controls” on page 3•2). The icon 
for the respective effect within the Signal Flow Panel dims to indicate its Off state:

FX Model On FX Model Off Amp Model On Amp Model Off

“Null” Block Indicator

Whenever an FX or Amp Block is “empty” (its Model Type selector is set to “---”) the Block appears in 
the SFV as a “Null” Model to indicate this disabled state.

Null FX Block Null Amp Block

Note that Null Model Blocks can still be selected and moved, just like active FX and Amp Blocks. 
Once you select a Model for the Block, the icon in the SFV changes to indicate the chosen Model.
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Model Position

The position you see the Models appear left to right in the Signal Flow Panel is precisely the order your 
input signal flows through them. Just as in the “analog world,” the ordering of your FX can change the 
sound you get from them - e.g. a Chorus or Phaser will sound different before versus after a Distortion.* 
You can use the handy Move buttons in the Signal Flow View panel to reposition your FX and amp 
Blocks as desired.

*Note: Some FX are stereo and others are mono (and all Amps & Preamps are mono), therefore, a stereo 
signal is typically “mono-ized” at the output of a mono Block. Please see the POD HD500 Advanced 
Guide for more about Model positioning and the signal flow - http://line6.com/support/manuals.

 “Pre” position Path A Path B “Post” position 

The positions within the Signal Flow

Moving FX & Amp Blocks

Rearranging the order of the Amp & FX Models in your Tone is as simple as dragging and dropping 
within the Signal Flow View panel!

 As soon as you hover your mouse cursor over an FX Block, you’ll see its respective FX edit panel below 
outlined - this allows you to know which Model your are accessing.

Arrow indicator appears when cursor is over an FX Block

Amber outline indicates the respective FX Block’s edit panel

http://line6.com/support/manuals/


2•7

POD HD500 Edit:  Overview

TIP: An FX Block containing the FX Loop can also be moved like any other FX Block, allowing you to 
place your POD HD500 analog FX Loop’s Send/Return at any point in your signal chain - including in the 
parallel Paths A or B!

As you click and drag a Block, you’ll see any potential “drop” location for the Block be indicated by 
a vertical bar, as shown below. Simply release the mouse button to move the Block to this indicated 
location. 

Dragging an FX Block, from Post to Path A Dragging an Amp Block, from Path A to Post

Any of the 8 FX Blocks can be moved to any position within the Pre, Post, Path A or Path B areas. A 
few different rules apply for moving Amp Blocks:

•	 Only one Amp Block can exist in your Tone when placed in the Pre or Post SFV positions. 

•	 An Amp Block in Pre position can be placed only at the end of the Pre section, after any 
Pre FX.

Amp Model in the Pre position

•	 An Amp Block in the Post position can be placed only at the start of the Post section, before 
any Post FX.

Amp Model in the Post position

•	 When moved into Path A, a 2nd (“Null”) Amp Block is automatically created in Path B, for 
which you can choose an Amp/Preamp Model, if desired.

Dual Amps within Paths A & B - Amp B is in the “Null” (disabled) state



2•8

POD HD500 Edit:  Overview

•	 The Amp Block in Path A (“Amp A”) can be moved left or right into either the Pre or Post 
positions, as shown above. Once moved out of Path A, the Amp B block is automatically removed 
from the signal flow. Amp A cannot be moved down into Path B.

•	 Amp Blocks cannot be moved to different positions within Path A or B (however, you can move 
FX Blocks before or after Amps within these Paths). Amp B cannot be moved at all from its Path 
B position.

Menu Commands

To follow are descriptions of the application’s menu commands and their functions. The location of 
some commands are different on Mac® versus Windows® systems, as noted below.

POD HD500 Edit (This menu is shown only on Mac®)

•	 About POD HD500 Edit - Launches the About box, which includes info about your connected 
hardware and software version.

•	 Quit POD HD500 Edit - Exits the application.

File (Also see “Saving and Opening POD HD500 Preset Files” on page 1•4.)

•	 Open - Allows you to load a saved POD HD500 Edit Preset (.h5e) file from any folder on your 
computer. 

•	 Save As - Allows you to save a copy of the loaded Preset as a POD HD500 Edit Preset file (.h5e) 
to any folder on your computer. 

•	 Open Bundle - Loads a saved POD HD500 Edit “Bundle” (.h5b) file from any folder on your 
computer, replacing all Presets within the application.

•	 Save Bundle As - Allows you to save all current Preset settings as a POD HD500 Edit “Bundle” 
(.h5b) file to any folder on your computer. 

•	 Open Set List - Loads a saved POD HD500 Edit Set List (.h5s) file from any folder on your 
computer, replacing the currently loaded Set List and all its Presets.

•	 Save Set List As - Allows you to save the currently loaded Set List, along with all its Presets & 
their current settings, as a POD HD500 Edit Set List(.h5s) file to any folder on your computer.

•	 Exit (Windows® only) - Exits the application.

Help

•	 POD HD500 Edit Help - Launches this PDF document you are now reading.

•	 Online Help - Takes you directly to the Line 6 Community site, the place to find additional 
documentation, FAQs, User Forums, Technical Support, breaking news and more!

•	 CustomTone.com - Takes you to the Line 6 CustomTone site, where you can share your Tone 
Presets with thousands of other Line 6 users, and download free Tones from the huge library!

•	 About POD HD500 Edit (Windows® only) - Launches the About box, which includes info 
about your software version and connected device.
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Editing FX & Amps
This area of the GUI offers 5 buttons to display each of the different Edit Panel “Views” - FX, Amps, 
Mixer, Controllers and Set Lists. In this chapter we’ll cover the FX and Amps Views.

Working with FX Edit Panels

Within the FX View, you’ll see an individual “Edit Panel” for each of the 8 FX Blocks. These panels 
provide you easy access to select the desired FX Model and all its individual parameters for each Block, 
making deep editing easier than ever! 

Edit Panel display selector buttons

The Edit Panel display - FX View selected

FX Panel Indicators

Each FX Panel also offers a few useful visual indicators. Note that, since any of the 8 FX Blocks can be 
moved into any position within the Tone’s signal flow, the FX Edit Panels will not necessarily be in a 
vertical order that matches the FX Blocks’ Left-Right order in the Tone. 

When you hover your mouse cursor over an FX Block within the Signal Flow View, you’ll see a black 
down arrow appear over the FX Block in the SFV. When this black down arrow appears in the SFV, the 
corresponding FX Edit Panel becomes outlined to indicate it is the Edit Panel for this Block’s settings, 
as shown below. This FX Panel outline is displayed whether the Model is On or Bypassed. 
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When hovering mouse over the Delay FX Block, the black arrow is displayed...

...The respective FX Edit Panel is outlined

FX Panel Controls

You’ll see that the controls displayed within each Edit Panel are specific to the FX Model selected. To 
follow are descriptions of the different FX Edit Panel controls.

FX Model menu / Bar Value displayModel-specific controls

On/Off LED switch FX Model Type selector / Numerical Value display

•	 Knob controls - Click and drag any knob vertically to adjust its value. Or, click to “select” a 
knob and then use your computer’s arrow keys or mouse wheel to adjust it. Also, simply hovering 
your mouse cursor over any knob allows it to be adjusted via your mouse wheel. Most knob 
controls also include a numerical indicator/edit box that provides access to the parameter value 
as well (see the following description).

•	 On/Off FX switch - At the left of each FX Panel, you’ll see a little “LED” On/Off control. Click 
directly on this LED to toggle the Model between On or Off. You’ll see the LED and all edit 
boxes dim to indicate the Model’s Off (bypassed) state. Note that you’ll also see the Model’s icon 
within the Signal Flow View dim when Off - see “Signal Flow View Features” on page 2•5. The 
panel’s knobs and text fields are not able to be edited when toggled Off. 

On

Off
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•	 Model Type menu - Click the down arrow to select from the list of FX Model categories. This 
list offers the same options for each FX Panel. Selecting “---” sets the FX Block to the “Null” 
(disabled) mode, which is essentially an empty FX Block (and thus, a blank, “Null” FX Panel) 
that utilizes no POD HD500 DSP resources.

The Model Type Menu

•	 FX Model menu - Click the down arrow to select from the list of Models within the selected 
Model category. The FX Block’s icon displayed in the Signal Flow View will dynamically change 
to illustrate the specific Model you select.

The Model Select menu

•	 Numerical indicator/edit boxes - Some knob controls have an adjacent text box that shows the 
numerical setting value. You can also click on the text box and drag up/down to adjust its value, 
or double-click within any box to type in a specific numerical value. Also, simply hovering your 
mouse cursor over any numerical edit box or knob allows it to be adjusted via your mouse wheel.

Double-click and type in a valueClick and drag vertically

•	 Mix knob value indicators - For knobs that do not include an adjacent text box (typically a few 
of the knobs at the far right of some panels), these controls utilize the FX Type and Model Select 
boxes at the right of the panel to indicate their values. Just rotate one of these knobs and you’ll 
see this in action, such as when turning the Mix knob for most FX. 

Numerical indicator display Bar value display

Adjusting an FX Panel’s Mix knob
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Tempo Sync Parameter

When a Modulation, Filter or Delay Model Type is selected, you’ll see a “Tempo Sync” control, which 
offers a selection of “Off” or several note division options. 

Note: The “system” Tempo Sync option within the Mixer View further allows you to choose whether the 
FX follow the Tap Tempo as a per-Preset value or globally - see page 4•3.

Modulation FX - Tempo Sync & Speed Delay FX - Tempo Sync & Time

•	 When set to Off: The “Speed” or “Time” option to its right can be used to manually choose any 
desired rate for the effect’s modulation speed (Hz) or delay time (ms). 

•	 When set to a note value: The Tempo Sync is active, meaning the effect’s speed or time utilizes 
the current “Tap Tempo” value, divided by your selected note value. 

•	 Stereo Delay FX Model: Note that the Stereo Delay includes two, independent Delay Time 
parameters, therefore, you’ll see 2 Tempo Sync options (“Sync Left” and “Sync Right”) in the FX 
Edit Panel for this Model so that you can set each Time independently!

The two, independent Tempo Sync options for the Stereo Delay FX Model

Trails Option 

Note that the “Trails” On/Off setting found in the Mixer View (see page 4•3) allows  echo repeats and/or 
the decay of Delay and Reverb FX to continue when the Model is toggled off. 

Pedal Assigned Parameters

When an FX parameter is assigned to the EXP 1 or EXP 2 Pedal Controllers, you’ll see this indicated 
within the FX Edit Panel (for parameters that include a numerical value box). The respective control 
for the parameter will display this “EXP-1” or “EXP-2” assignment in place of the numerical value - a 
reminder that this parameter can only be controlled via the Pedal. (Please also see “To Assign an FX 
or Amp Parameter to a Pedal Controller” on page 5•3.) 

•	 For example, if the Pitch Glide Model’s “Pitch” parameter is assigned to Pedal EXP-1, the Panel 
appears like this:

The Pitch parameter edit box shows the current EXP-1 Pedal assignment

•	 When a parameter is assigned to a Pedal, adjusting the respective Panel’s knob (such as for the 
“Pitch” knob in our above example) does not send any info to the device.

Note: For Wah and Volume FX Models, if their “Position” parameter is not assigned to an EXP Pedal, 
the Panel’s Position knob can be used to dial in a fixed value - such as a “parked” Wah tone for the Wah!



3•5

POD HD500 Edit:  Editing FX & Amps

Working with Amp Edit Panels

Select the AMPS button to display the Amp Edit Panels. Here you can access all options for selecting 
Amp/Preamp, Cab & Mic Models & edit all their parameters. Here you can also access the parameters 
that are sent to any L6 LINK™ connected DT50™ amplifier!

Amp On/Off

DT50 controls

Amp Model 
controls

Amp tone knobs

Class switch 
Topology Voicing selector Cab selector 

Pentode/Triode Mode switch 
Power Amp parameters 

Amp Model selector
Mic selector

E.R. control Amp Enable/Disable

Above is an example of the Amps View for a Tone that includes one Amp Block. When only one Amp 
Block exists, it is always “Amp A.” When the Tone includes two Amp Blocks, you’ll see an additional 
“Amp B” edit panel - its controls are the same as described for Amp A, except where noted below (see 
“Dual Amp Tones” on page 3•7). 

•	 Amp On/Off - When Off, all controls for the Amp, Cab & Mic Models are disabled, as well 
as the DT50 amp settings. Additionally, the CH VOL knob changes to an active BYP VOL 
(bypassed volume) knob, providing level adjustment for the signal fed through the Amp Block.

 

BYP VOL becomes availableAmp Off (bypassed)

•	 Amp Model selector - Click on the Amp Model menu to select an Amp or Preamp Model. Note 
that when selecting an Amp Model this way, the default settings for the specific Amp are loaded.

•	 Amp tone knobs - Just as on your POD HD500 hardware, use the knobs here to adjust the 
Amp’s gain & EQ. Note that some Amp Models include a few knobs that are labeled differently 
than the POD HD500 physical Amp knobs. In the cases where the classic amps we’ve modeled 
include special knob controls, we’ve emulated their behaviors accordingly. These are listed as 
follows:
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•	 Super O - The actual Supro®* amp we modeled has only a Drive and a Tone knob. 
Therefore, in the Amp Panel we have a knob labeled “Tone” (which we mapped to the POD 
HD500 device’s MID knob) and we invented Bass, Treble, and Presence controls.

•	 Divide 9/15 - The Divided by 13 amp we modeled offers two interactive channels. Therefore, 
in the Amp Panel we have a “Drive 1” knob (mapped to the device’s DRIVE knob) which  
controls the “clean” channel level, and a “Drive 2” knob (mapped to the device’s BASS 
knob) which controls the “dirty” channel level. Also, we’ve added “Tone” & “Cut” knobs 
in the Amp Panel to emulate these original amp controls (which are mapped to the device’s 
MID & TREBLE knobs, respectively).

•	 Class A-15 & Class A-30TB -  Following the design of the Vox®* amps we modeled, 
we’ve added a “Cut” knob in the Amp Panel (which is mapped to the device’s MID knob).
Turning the “Cut” knob counter-clockwise reduces the high end frequencies.

•	 Early Reflections (E.R.) control - Add the desired amount of reflective “room” sound to your 
amp tone. This is the equivalent of the E.R. control found in the Amp-Edit Mode, page 2 screen 
of your device.

•	 Mic selector - Choose from among the 8 different Microphone Models to use to mic your Amp.

•	 Cab selector - Choose from among the list of speaker cabinets to use with your Amp.

•	 Power Amp parameters - The 5 knobs here relate to the “Power Amp” parameters (Master 
Volume, Sag, Hum, Bias & Bias Excursion) found within the device’s Amp Edit screens whenever 
a “Full” Amp Model is in use.* When adjusting one of these knobs, its value is displayed as 
shown below:

The Power Amp parameter knobs - value is indicated while adjusting

* Note: When a Preamp Model is in use, the “Power Amp” knobs are not displayed at all within the Amp 
Edit panel (just as they are not displayed in the hardware Amp Edit panel for a Preamp Model).

* All product names are trademarks of their respective owners, which are in no way associated or affiliated with Line 6. These product names and descriptions are provided for the sole purpose of identifying the 
specific products that were studied during Line 6’s sound model development. Supro® is a registered trademark of Zinky Electronics. Vox® is a registered trademark of Vox R&D Limited. 
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•	 Amp Enable/Disable switch - Clicking on this “X” button at the top right of each Amp  
panel has the same result as choosing the “---” (no amp) option in the Amp Model selector. 
It unloads the Amp/Cab/Mic Models and places the Amp Block in a “Null” (disabled) 

state. You’ll see the Null Amp Block displayed in the Signal Flow Panel to indicate this state as 
well. (To “Enable” the Amp Block again, choose the desired Amp using the Amp Model selector.)

The Amp Panel in the “Null” (disabled) state

The respective “Null” Amp
 Block shown within the SFV

TIP: Any of the Amp Tone Knobs can optionally be controlled with the POD HD500 EXP 1 or EXP 2 
Pedal Controllers! See “To Assign an FX or Amp Parameter to a Pedal Controller” on page 5•3.

Dual Amp Tones

As mentioned above, when your tone includes 2 Amp Models, you’ll see an additional “Amp B” edit 
panel displayed. Its controls adjust the Amp B parameters independently, just as described above for 
Amp A. A few specific Amp B behaviors apply. 

The Amp Edit View with a Dual Amp Tone loaded

•	 Removing Amp B: It is possible to remove Amp B from your Tone - For example, if you move 
Amp A out of Path A to the Pre or Post positions, Amp B is automatically removed. (It is not 
possible to move Amp B’s position.) When Amp B is removed, you’ll see its Amp Edit Panel 
removed from the Amp Edit View as well.

•	 DT50 Settings: The Amp A & B Models each have their own set of DT50 settings - see next 
section.
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DT50 Amplifier Controls

DT50 Controls

There are two sets of DT50 controls available within the Amp panel: one each for the Amp A Model 
and Amp B Model. Each set of controls can be used to configure the DT50 amplifier’s tube power amp 
Topology parameters for the selected Amp Model. These settings are saved with your Preset, but only 
utilized when your POD HD500 is connected to one or more Line 6 DT50 amplifiers via the L6 LINK 
connection.*

*Note: These DT50 settings are strictly for the power amp Topology settings utilized by DT50 amps via 
the L6 LINK connection. The POD HD500 Amp/Preamp Models’ “Audio” & “Control” signals fed to 
each connected DT50 is separately determined by settings made using the L6 LINK options within the 
Mixer View - see “L6 LINK Audio & Control Options” on page 4•2.

•	 When choosing a new Amp/Preamp Model, we’ve already pre-configured default settings for 
these 3 parameters to match those of each classic amplifier that we modeled. But you can change 
these settings within the DT50 panels as desired to coax completely different analog power amp 
Topology combinations from your DT50! 

•	 Class switch - Toggles the DT50 power amp to function in Class A or Class AB operation.

•	 Topology Voicing selector - Chooses the DT50 Negative Feedback Loop Topology type (I, 
II, III or IV), as well as other power amp circuitry voicings.

•	 Mode switch - Selects the DT50 power tube mode between Triode or Pentode.

Please also see the and additional POD HD - L6 LINK documentation available at http://line6.com/
support/manuals/ for more details about these DT50 amplifier settings and L6 LINK connectivity.

Line 6 DT50 Combo Amplifier

http://line6.com/support/manuals/
http://line6.com/support/manuals/




4•1

POD HD500 Edit:  Mixer View

Mixer View

In this chapter, we’ll cover the Mixer View, where you’ll find controls for the Mixer Block, Variax® 
VDI Input, L6 LINK™, and Tempo Sync & Trails options.

Mixer Block & Variax Options

The Main Mix and Variax Input controls

Main Mix Controls

These controls at the left are the equivalent of the Mixer Block parameters available on your device 
when selected within the SFV. These faders & knobs offer independent Level and Pan control for the 
stereo signals from Path A and Path B, which are then fed into any Models in the “Post” SFV position 
and out to the device’s outputs. These settings are saved per Preset.

For additional details on POD HD500 signal routing, please refer to the POD HD500 Advanced 
Guide, available from the Line 6 Product Manuals page.

•	 Level Faders: Adjust the output level from Path A or Path B from “Mute” to +12dB. Just drag 
the fader or numerical edit box below it with your mouse, or, once you click on the fader, use 
your mouse wheel or computer arrow keys to adjust it. Alternatively, you can double-click in the 
numerical box and type in a specific value.

•	 Pan Knobs: Adjust the knobs to Pan the Path A or Path B output signal. Use your mouse, arrow 
keys on the knob or edit box as described above for the faders.

•	 If you have a dual Amp Tone configuration, try panning each Path opposite and adjust 
the levels of each to taste for a huge stereo sound with two different amp sounds. Also try 
moving different FX Models into each path for even more dramatic stereo results!

Variax Input Controls

If you are using any Line 6 Variax Guitar or Bass, connect it to the VARIAX VDI input on the back 
of POD HD500 and select “Variax” for at least one of your Source Inputs (see the Input settings on 
page 2•2). The Variax options here allow you to then choose your Variax instrument type and its control 
settings. These options are the same as offered within the device’s Setup:Variax screens.

•	 VDI (Variax Digital Interface) Input: Select your specific Variax instrument type here. Once 
selected (as well as with Variax Control set to “Enabled”) you’ll see the options to the right 
change to match your specific Variax instrument type.

http://line6.com/support/manuals/
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•	 Variax Control: This option determines whether your Variax Model and Tone Knob settings are 
controlled by POD HD500. 

 

Note: When set to “Enabled,” all the Variax parameter values here are saved per Preset. When set to 
“Disabled” they are not. Therefore, if you have some Presets where you’ll be using your Variax, but 
do NOT want its settings changed, keep this set to “Enabled” and choose “Don’t Force” for the Model 
parameter. This allows you to switch Presets to a state where your Variax settings do not change, then 
switch to a Preset where they do!

•	 Tone Knob(s): You’ll see knobs corresponding to your Variax Guitar/Bass knobs here. Set each 
to the desired setting for the Preset.

•	 Model: Select the Variax Guitar/Bass Model here. Or, set to “Don’t Force” if you prefer to not 
have the Variax Model auto-selected by the POD HD500 Preset, as noted above.

L6 LINK Audio & Control Options

The L6 LINK Audio & Control options for up to four DT50 amplifiers

These options are the equivalent of those found in the Setup - L6 LINK:Audio and L6 LINK:Control 
screens of your POD HD500 device - changes made via the hardware or software are reflected in both. 
All options here are saved per Preset. To follow is an overview for these settings. 

Note: Use the DT50 options for each Amp Model within the Amps View panel to customize the power 
amp Topology settings that DT50 utilizes for each of the Preset’s Amp Models - see “DT50 Amplifier 
Controls” on page 3•8.

Amp 1 - Amp 4, Audio Options 

The selection you make for each of these options determines the mono audio signal that is fed to 
each DT50 amplifier:

•	 Choose the main output signal by selecting either Left, Right, or Left/Right (summed).

•	 Choose from the output point of one specific Amp Model by selecting either Amp Model A or 
Amp Model B.

Amp 1 - Amp 4, Control Options 

The selection you make for each of these options determines whether each connected DT50 
amplifier “follows” the POD HD500 Amp Models & settings and/or other connected DT50 amps’ 
settings. 
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•	 Each DT50 can be set independently to follow either the current Preset’s Amp Model A or Amp 
Model B.

•	  DT50 automatically configures its power amp Topology settings to match the selected Amp 
Model A or B. 

•	 The DT50 amp controls are also synced to the selected Amp Model A or B.

•	 Alternatively, you can select one of the unused MIDI Channels to set the DT50’s MIDI 
communication channel. This effectively sets the respective DT50 to utilize its own internal 
Amp Model (rather than the POD HD500 Amp Model), and “syncs” its front panel controls 
with other DT50 amps that are set to the same MIDI Channel.

L6 LINK offers a great deal of flexibility and instructions differ depending upon the number of DT50 
amplifiers connected and the results you wish to achieve. Please see the additional POD HD - DT50 L6 
LINK Connectivity Guide available at http://line6.com/support/manuals/ for the full info!

Tempo Sync & Trails Options

The Tempo Sync and Trails options

As described on page 2•2, Tempo-based FX each include their own, individual “Tempo Sync” option to 
either follow the Tap Tempo BPM value, or to be set manually. Additionally, this “system” Tempo Sync 
option here in the Mixer View allows you to choose whether the FX follow the Tap Tempo as a per-
Preset value or globally. This Tempo Sync option is the equivalent of the option found in your device’s 
Setup:MIDI/Tempo screen. 

•	 When set to Preset: Tempo settings are saved and recalled on a per Preset basis. 

•	 When set to Global: Tempo information stored within any Preset is ignored. When saving a 
Preset while set to Global Tempo Sync, the Global tempo value will be saved with the Preset.

http://line6.com/support/manuals/
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Configuring Footswitches & Controllers

In this chapter we’ll cover the Controllers View Panel, where you can create and customize Pedal 
Controller & Footswitch assignments for your POD® HD500 Presets. Additionally, you can use the 
MIDI Assign functions to independently allow your device’s footswitches or Pedals to transmit MIDI 
control messages, turning your POD HD500 into a handy MIDI Controller device for your other MIDI 
gear!

The Controllers & Footswitches Options

The Controllers and Pedal Assignment options

These options allow you to configure “On/Off” Footswitch and/or Pedal Controller assignments for 
any of the current Preset’s Amp or FX Model parameters. These options are the equivalent of those 
found in your device’s Controller Assign screen. The Footswitches pane provides a handy at-a-glance 
reference for the existing footswitch assignments for FS1 - FS8, as well as the On/Off state of each. You 
can also click on the FS buttons in the pane to remotely toggle FS1 - FS8. To follow are instructions 
on how to use these options. 

To Assign an FX or Amp Model to a Footswitch

Start by loading a saved Preset, or customize one to add your desired Amp & FX Models. For this 
example, we’ll assign our tone’s Dynamics-Boost Comp FX Model to FS1 so that it can be toggled On/
Off via this footswitch. 

 

Note: POD HD500 footswitches FS5 through FS8 can be configured to either “Pedalboard Mode” 
(where they can be assigned to toggle Models On/Off) or “Presets Mode” (where they recall the current 
Bank’s A, B, C or D Presets). This is configured within your device’s Setup:Utilities screen.

In the Controllers pane, initially you’ll see all the fields appear blank. This is the normal default state 
until you select a Model to configure assignments for it.

The Controllers pane - initial “blank” default state
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Click on the Models menu. Here you’ll see each of the Amp & FX Models that are loaded within your 
current Tone. We’ll select the Boost Comp Model for our example.

The Controllers - Model menu, selecting the Boost Comp 

Once a Model is selected, the next step is to click on the FS Assign menu. Here you can select the 
footswitch to which you want to assign the Model. Choose from among FS1 - FS8, Toe Switch, or 
None. (You can choose None for any Model that is currently assigned to remove its FS assignment.) 
We’ll choose FS1 to toggle the Boost Comp with this footswitch...

The completed Model Assignment 
appears in the respective FS slot

Assigning the Boost Comp Model to FS1

This completes the FS assignment. Click directly on the FS1 switch in the Footswitches pane, or 
stomp on FS1 on your device to give it a try. Repeat the above steps to assign other Amp or FX Model 
to other Footswitches as desired.

Optionally, 2 or more Models can be assigned to the same, single footswitch. This can be a clever way 
to toggle between two different FX Models. For example, say you have two different Distortion Models 
loaded in the same Preset, and you’d only like to use one at a time, but want to toggle between them 
to utilize their different sounds for different parts of your song performance... 

•	 To create this configuration, go into the FX Edit Panel screen and toggle one Distortion Model 
“On” and the Other “Off” to start. Then repeat the above steps, selecting each Distortion Model 
and assigning each Model to the same Footswitch. When two or more Models are assigned to the 
same footswitch, this FS is labeled as “Multi” to indicate this multiple assignment:

A Footswitch with a multiple Models assigned

•	 Now when you stomp on this footswitch, you’ll see (and hear) one Distortion Model toggle Off, 
while the other simultaneously toggles On! This type of switch assignment is exactly what we’ve 
done for any Factory Preset where you see both a Wah and Volume Pedal FX, where we assigned 
both FX Models to the Toe Switch to allow you to toggle between using either Wah or Volume 
via the Pedal’s Toe Switch.
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Note each Model can only be assigned to one Footswitch maximum. That is, if you select a Model that 
is currently assigned to a footswitch and select a different footswitch from the FS menu, the assignment 
for the Model is removed from the previous FS and established on the new, selected FS.

Be sure to save your Preset once your footswitch assignments are complete to retain your settings 
with the Preset!

To Assign an FX or Amp Parameter to a Pedal Controller

You can choose from among hundreds of Amp & FX Model parameters to be assigned to the POD 
HD500 EXP 1 or EXP 2 Pedals!* Start by loading or customizing a Preset to include an Amp or FX 
Model which includes a parameter you’d like to control with an EXP Pedal.

 

*Note: The POD HD500 on-board Pedal can be switched between controlling EXP 1 or EXP 2. Or, if 
you connect an Expression Pedal to the PEDAL 2 jack, the on-board pedal becomes dedicated to EXP 
1 and Pedal 2 to EXP 2. See the POD HD500 Advanced Guide for more info on using Pedals.

•	 First, select the desired Model for which you’d like to control a parameter. Clicking on the 
Controllers pane - Model menu shows the list of all loaded Models for the current Preset. For 
this example, we’ll configure the Delay-Tube Echo FX Model’s Mix parameter to be controlled 
by EXP 1. 

Selecting the Tube Echo in the Model Menu

•	 Once a Model is selected, the next step is to click on the Parameter menu. Here you can select 
any listed parameter for this Model - we’ll choose Mix.

Selecting the Tube Echo’s Mix parameter

•	 Now, in the Controller menu, choose the EXP 1 or EXP 2 for the desired Pedal Controller. If 
you’ve selected a parameter in the previous step that was already assigned to EXP 1 or EXP 2, 
you can choose Off to remove the Pedal assignment.

Choosing the EXP 1 Pedal Controller

http://line6.com/support/manuals/
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•	 Finally, if you’d like to set the Min (“heel”) and/or Max (“toe”) values for the Pedal range for this 
parameter, adjust the knobs here. 

Adjusting the Min/Max Pedal range

•	 This completes the Pedal Controller assignment. The Controllers pane will now display your 
settings. Note that the Pedal Controller assignment is specific to the Amp or FX Block’s Model 
for which you created it. If you change the Block to a different Model, the Pedal assignment is 
discarded.

The Controller pane showing our completed Pedal assignment

•	 Repeat the above steps to assign another Model’s Parameter to EXP 2, if desired. It is also possible 
to assign multiple parameters to one, common EXP Pedal Controller, with the result being that 
all parameters are controlled simultaneously with the one Pedal. There are no rules here, so get 
as wild as you like for Pedal control!

 

Note: When you add a Wah FX Model to your tone, the “Position” parameter for the Wah is 
automatically assigned to EXP 1. Likewise, when adding a Volume or Pan FX Model, its Position 
parameter is automatically assigned to EXP 2. This will result in multiple items assigned to these EXP 
Pedals if you already have existing Pedal Controller assignments. For all Factory Presets that already 
include a Wah, Volume or Pan, these are typically already assigned as well. 

Be sure to save your Preset once your Pedal Assignments are complete to retain the settings with 
the Preset.

The MIDI Assign Options

The MIDI Assign options pane

These options are the equivalent of those found in the MIDI Assign screen of your POD HD500 
device - changes made via the hardware or software are reflected in both. You can configure any of 
the device’s footswitches or Pedals to transmit MIDI Control messages to its MIDI OUT port. This 
allows you to utilize POD HD500 as a MIDI Controller Device for any connected MIDI hardware or 
software that responds to these message types (MIDI CC, Bank or Program Change or Note On). All 
options here are saved per Preset. Note that these MIDI assignments are completely independent of 
any assignments made in the upper Controllers and Footswitches panes.
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Creating & Editing a MIDI Assignment

To create a MIDI Assignment for any footswitch or Pedal (or to edit an existing assignment), first use 
the Footswitch knob to choose the desired switch or Pedal - you’ll then be able to access its available 
options. Once the desired switch/Pedal is selected, you’ll see the device’s MIDI Assign LCD screen 
display and operate in sync when accessing any other parameters. To follow are descriptions on the 
MIDI Assignment options, and some tips on how to use them. 

 

Note: More details about POD HD500 MIDI Control functionality and MIDI message types can be 
found in the POD HD500 Advanced Guide. 

•	 Footswitch: Select the desired footswitch or Pedal for which you want to create an assignment, 
or to view or edit an existing assignment. Choose from FS1 through FS8, LOOPER, TAP, EXP 
TOE (the “Toe Switch” of your on-board Pedal) footswitches, or EXP1 or EXP2 Pedals. 

•	 MIDI Channel: Next, choose the MIDI Channel on which the selected footswitch/Pedal control 
will transmit its MIDI command. 

•	 None: Sends no MIDI data. (Note that you won’t see other options in this panel become 
editable until you select an option other than “None.”)

•	 Base: Sets a the control to follow the current “global” MIDI Channel, as set in the device 
Setup - MIDI/Tempo screen. This is a handy feature to have any Presets’ MIDI Controls set 
to “Base” to dynamically follow the common Setup -MIDI Channel value.

•	 01 - 16: Choose the MIDI Channel on which to transmit the selected control’s messages.

 

Note: The L6 LINK Control communication also utilizes the device’s same MIDI Channels, therefore, 
you’ll want to set these MIDI Assign options and L6 LINK Control options to different MIDI 
Channels if you are to be using both! Also see “L6 LINK Audio & Control Options” on page 4•2.

•	 Message: Once you’ve selected the desired MIDI Channel, use this knob to choose the type of 
MIDI message sent by the selected control. Note that you’ll see different Message types available 
depending on the “Footswitch” control you have selected:

•	 FS1 - FS8, LOOPER and TAP footswitches can each be assigned to send MIDI CC, CC 
Toggle, Program Change (fixed), Bank Change (fixed) or Note On messages. 

•	 The EXP TOE SWITCH can be assigned to send two separate MIDI CC Toggle commands, 
which allows it to alternately toggle between two functions on your target device.

•	 The EXP1 and EXP2 pedal controls can be assigned to each send one MIDI CC with 
a definable Value Range, which allows you to sweep a variable parameter on your target 
device.

•	 CC #, Bank and Program: These knobs select further options, depending on the Message Type 
selected with the previous knob.

•	 CC #: When the Message Type is “CC” or “CC Toggle,” this allows the choice of any 
MIDI CC number from 000 to 127. If editing EXP1 or EXP2 controls, this knob sets the 
Minimum CC value for the pedal. (Also see the following Value knob description.)

•	 Bank: When the Message Type is “Bank Change,” this allows the choice of fixed Bank 
Value of 000 to 127.

•	 Program: When the Message Type is “Program Change,” this allows the choice of a fixed 
Program Value of 000 to 127.

•	 Note: When the Message Type is “Note On,” this allows the choice of the specific musical 
note value (C0 to G9)

http://line6.com/support/manuals/
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•	 Value and Velocity: These knobs select further options, depending on the Message Type settings.

•	 Value (CC): When the Message Type is “CC,” this sets the value for the CC that is sent on 
every press of the switch control (000 - 127). When editing the EXP1 or EXP2 controls, 
this sets the Maximum Value for the Pedal.

•	 Value (CC Toggle):When the Message Type is “CC Toggle,” you can select 000 or 127 to 
choose an “On” or “Off.” The control sends alternating messages per click.

•	 Velocity: Sets the Velocity value for the Note message (000 - 127).

•	 Note that no option is available if the Message Type is “Program Change” or “Bank Change.”

•	 Min and Max: When either EXP1 or EXP2 is the current control selected in the Footswitch field, 
these two knobs become available. Use the Min. to configure the minimum (heel position) value 
of the Pedal, and the Max. to configure the maximum (toe position) value. Typically, you’ll want 
to set Min. to 000 and Max. to 127 to access the full range of the parameter you are controlling.

Be sure to save your Preset once your MIDI Assignments are complete to retain the settings with 
the Preset.
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Set Lists and Presets
The Set Lists View is the place where you can access all your POD® HD500 Set Lists, and all Presets 
within them. In this chapter, we’ll cover all the possibilities for managing your Set Lists & Presets using 
both the Set Lists View as well as the main Presets Panel. 

The Set Lists View

 

It is important to note that none of the changes to the Preset Panel & Set Lists contents are committed to 
the internal memory of your device until you “Send” your Preset(s) to the device, which you perform using 
the Save Controls (see page 2•1). Or, you can use the File menu’s Save As commands to save copies of 
any Preset, Set List or complete Bundle to your computer. It is a good idea to perform a save of all Presets 
to create a full backup Bundle on your computer before editing and/or reordering Presets - see “Saving and 
Opening POD HD500 Preset Files” on page 1•4.

Main Presets Panel

Although not part of the Set Lists View, the Presets Panel within the main GUI offers many features 
for managing Presets, and it is helpful for you to take a look at this panel first. Start by selecting any 
View other than the Set Lists View to allow the main Presets Panel to be accessed. The main Presets 
Panel always displays the Set List currently loaded in POD HD500, and the selector at the top allows 
you to choose any of the 8 Set Lists from your device’s internal memory. You can select any of the 
current Set List’s 64 Preset locations (01A - 16D) to load its Preset, or perform other actions.  
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Set List selector

Edited Preset (indicated in 
amber, italicized text, with 
an asterisk at right)

Currently loaded Preset 
(indicated by arrow at left) 

Selected Preset (indicated 
by highlight)

The main Presets Panel

The edited, currently loaded and selected Preset states are also indicated the same way within Set Lists 
View. See the next section for actions that are possible within the main Presets Panel, as well as within 
the Set Lists View panels.

Set Lists View Panels

When you want to do more than just manage the current Tones in the main Presets Panel, click on 
the Set Lists button to display the full Set Lists View. The main Presets Panel at the left will become 
disabled when the Set Lists View is displayed. Just as with the main Presets Panel, each Set List panel 
within the Set Lists View provides access to each of its 64 Preset locations. To follow are the actions 
possible within any Set List (as well as within the main Presets Panel when it is active).

•	 Load a Preset: Double-click on any Preset to load its settings into the editor, or hit “Enter” on 
your computer keyboard to load the currently selected Preset. If you select a Preset within a 
different Set List Panel than the currently loaded one, this loads the new Set List as well.

•	 Select a Preset: Click once on any Preset to “select” it. Note that this does not load the Preset, 
but rather allows you to perform actions on the Preset - such as to “Send” or “Receive” Presets 
(see the Save Controls on page 2•1). 

•	 Multi-Select Presets: It is also possible to select multiple Presets within the same panel: 

•	 Press and hold your Shift key+click to select a contiguous number of Presets.

•	 Press and hold your Cmd key+click (Mac®) or Ctrl key+click (Windows®) on the desired 
Presets to select a non-contiguous number of Presets.

Contiguous selection of multiple Presets Non-contiguous selection of multiple Presets

•	 It is not possible to drag multiple selected Presets within the same Set List Panel. But you 
can drag multiple-selected Presets into a different Set List Panel to copy them into the same 
respective Channel locations within the destination Set List.
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•	 “Insert” a Preset into a different Channel location: Click on a Preset and drag it up or down 
within the same Set List Panel. Drop the Preset onto the desired Channel location to move the 
Preset there. 

 

Note: Since this “insert” action re-orders Presets in the application, all the moved Presets are now in 
different Channel locations as compared to the Channel contents within your device’s internal memory and, 
therefore, are marked as “unsaved” in the Presets Panel. Use the Send buttons in the Save Panel to save 
the new Channel settings to your POD HD500 (see page 2•1). 

•	 Drag and drop a Preset from one Set List Panel into any channel location within a different 
Set List Panel and the Preset will be copied into the new location.

•	 “Swap” the Preset settings between two Channel locations: Click on a Preset to select it, then 
hold your Shift key and click and drag the Preset to the new desired Channel location - either 
within the same Set List Panel, or into a different Set List Panel.

•	 Copy & Paste a Preset to a new Channel location: Click on a Preset to select it. Then hold 
your Option key (on Mac®) or Ctrl key (on Windows®) and click and drag the Preset to the 
new desired Channel location. This replaces the Preset in the destination location. (Note that it 
is not necessary to hold any modifier key when dragging a Preset between two different Set List 
Panels to copy into the new location.)

•	 Save a Preset to your computer: There are a few ways to save a copy of the currently loaded 
Preset to your computer:

•	 Use the File menu’s “Save As” commands (see page 1•4 for more about saving and opening 
Preset, Bundle & Set List files). 

•	 Drag a Preset (or multiple selected Presets) from any Set Lists Panel (or from the main 
Presets Panel, when active) directly onto your Desktop, or into any folder on your computer. 

•	 To rename a Preset: Select the desired Preset, wait a second, then click again directly on the 
Preset name. You’ll see the Preset’s name become highlighted. Type in your own text and hit the 
Enter key. Be sure to do a Send or Save of the Preset to retain your modified name.
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Line 6 Monkey & Additional Resources
Line 6 Monkey™ is the intelligent updater utility automatically installed with the POD® HD500 
Edit application, or available from line6.com/monkey. It is highly recommended that you run Line 6 
Monkey often to be sure you have all your Line 6 products updated and registered. 

Using Line 6 Monkey

With POD HD500 connected & powered on (see “Computer Connectivity” on page 1•2), quit all other 
Line 6 and audio applications and launch Line 6 Monkey:

•	 On Mac®, go to Applications > Line 6 > Line 6 Monkey

•	 On Windows®, go to the Start button menu > Programs > Line 6 > Tools > Line 6 Monkey

If Monkey prompts you to register your POD HD500, then please do so now - it may be required to 
register to obtain some product updates. Follow the prompts through the quick online registration. 
Return to Line 6 Monkey once you’ve completed the registration. 

Monkey will then display your POD HD500 Driver and Device Firmware versions, available 
Applications and any available updates. 

The Line 6 Monkey Updates screen, with POD HD500 connected

http://line6.com/monkey/
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As an example, in the above screenshot Monkey has detected that a newer Firmware - Flash Memory 
version is available. In this scenario you can select the Flash Memory item and click Update Selection. 
Be sure to read the prompts carefully and Monkey will assist you in performing the update in minutes. 
It is especially important not to disturb the devices’ controls and cable connections until the update 
fully completes!

Additional Resources

Hungry for more info? We’ve got plenty of helpful online resources, just a click away.

•	 Additional Help documentation covering POD HD500 hardware, DT50 amplifiers and related 
products is available from the Line 6 Support site: 

Line 6 Product Manuals

•	 Visit the CustomTone™ site where you can share your POD HD500 Tones with the world, and 
download free Tones created by Line 6 and other users just like you:

CustomTone 

•	 Can’t get enough of that Line 6 Gear & accessories? Head on over to the Line 6 Store!

Line 6 Online Store

•	 Join the Community! Pay a visit to the Line 6 Communities page, where you can find FREE jam 
tracks, loops, practice tools, tips, special offers, discussion forums and more:

Line 6 Communities

•	 For Line 6 Support, including the searchable Knowledgebase:

Line 6 Support

http://line6.com/support/manuals/
http://line6.com/customtone/
http://www.line6.com/store/storefront.html
http://line6.com/community/
http://line6.com/support/
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